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AKVIS ENHANCER 17.5 | RECUPERO DEI DETTAGLI DI UNA FOTO

AKVIS Enhancer è un software innovativo per l'ottimizzazione fotografica. Il programma permette il recupero e
l'ottimizzazione dei dettagli anche in foto sottoesposte, sovraesposte e in aree dai mezzi toni senza però modificare
l'esposizione.

Il programma offre tre modalità: Migliorare i dettagli, Prestampa e Correzione toni. L'obiettivo principale di queste tre
modalità è lo stesso,  la correzione, ma il metodo utilizzato ed il risultato sono molto diversi. Immagini diverse richiedono
approcci di correzione differenti, quindi non è possibile prevedere in anticipo quale modalità sia più efficace. In molti casi tutte
e tre si integrano a vicenda, infatti apportare le modifiche con ognuna di loro può condurre ad un risultato dell’immagine
nettamente superiore.

Migliorare i dettagli. Questa modalità è utilissima su immagini piatte e carenti di dettagli. Ad esempio, una foto scattata con
uno sfondo sovraesposto e conseguentemente di difficile lettura, è il tipico problema che si presenta quando si scatta un
panorama o un ritratto su uno sfondo. Il programma porta alla luce i dettagli intensificando la transizione di colore, rafforza la
differenza tra pixels adiacenti aventi diverse tonalità di colore, mostrando ed accentuando quindi i dettagli sia in ombre che in
luci.

Prestampa. Questa modalità è utile quando si desidera approntare le foto per la stampa o pubblicare un album sul Web. Il
programma aumenta la nitidezza dei bordi ed il contrasto dell'immagine. Anche se non si ha intenzione di stampare le foto, è
possibile utilizzare questa modalità per migliorare le immagini.

Correzione toni. Questa modalità è utilizzata per correggere i toni dell'immagine, cioè è adatta alla correzione della luminosità
delle aree chiare e scure, di conseguenza l'impressione generale dell’immagine migliora notevolmente. Le modifiche possono
essere effettuate sull'intera immagine oppure solo ad una parte di essa, a seconda dei colori scelti per la correzione.

Schiarisci ed illumina le tue immagini con AKVIS Enhancer!
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Il software è utile non solo per la correzione di  foto di famiglia o  artistiche ma è anche perfetto per applicazioni
tecnologiche. Gli editori di pubblicazioni tecniche e scientifiche possono infatti trovare Enhancer di notevole efficacia per
rivelare maggior dettagli in immagini di apparecchiature scientifiche; in campo medico, ad esempio, Enhancer permette
l'incremento dei dettagli delle radiografie, etc.

AKVIS Enhancer è facile da utilizzare e da apprendere. Il programma permette di salvare come preset le impostazioni più
interessanti, per usarle successivamente.

Il programma supporta l’Elaborazione batch che consente di applicare automaticamente il processamento ad una serie di
immagini.

AKVIS Enhancer
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AKVIS Enhancer funziona come applicazione standalone e come plugin per i più diffusi programmi di grafica.

Il plugin Enhancer è compatibile con  AliveColors, Adobe Photoshop, Corel PaintShop Pro, ecc. Per maggiori dettagli sulla
compatibilità dei plugin AKVIS cliccare qui.

Durante il periodo di prova è possibile testare tutte le funzioni del software.
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COME INSTALLARE I PROGRAMMI AKVIS

Per installare AKVIS Enhancer sul computer con Windows seguire le istruzioni:

Fare doppio clic sul file di installazione exe.
Scegliere il linguaggio preferito (ad esempio, Italiano) e premere Installa.
Per procedere è necessario leggere ed accettare il Contratto di Licenza con l'utente finale.

Attivare la casella Accetto i termini del Contratto di Licenza e premere Avanti.

Selezionare i componenti per l’installazione. Per installare la versione plugin selezionare il programma(i) di grafica.

Per installare la versione standalone (il programma autonomo), controllare che sia attivata l'opzione corrispondente. È
possibile scegliere di creare un Collegamento sul Desktop per il programma.

Premere Avanti.

Premere Installa.
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Ora che tutti i dati necessari sono stati inseriti fare clic su Avanti per completare l'installazione.

L’installazione è in progressione.

L’installazione è completata.

È possibile iscriversi alle notizie di AKVIS (per essere sempre aggiornati). Per fare questo inserire l' indirizzo e-mail e
confermare di accettare l'Informativa sulla privacy.

AKVIS Enhancer

8



Premere Fine per uscire dall’installazione.

Dopo l’installazione della versione standalone si possono vedere il nome del programma nel menu di Start e un collegamento
sul Desktop, se durante l’installazione è stata attivata l'opzione corrispondente.

Dopo l’installazione del plugin si possono trovarlo nel menu Filtri/Effetti dell'editor di grafica. Ad esempio, in Photoshop:
Filtro -> AKVIS –> Enhancer.
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COME INSTALLARE I PROGRAMMI AKVIS

Per installare AKVIS Enhancer su Mac seguite le istruzioni:

Aprire il file dmg:

- akvis-enhancer-app.dmg per installare la versione Standalone (indipendente)

- akvis-enhancer-plugin.dmg per installare il Plugin in editor grafici.

Per procedere è necessario leggere ed accettare la Licenza d'uso.

Il Finder si aprirà con all’interno l’applicazione AKVIS Enhancer o con la cartella AKVIS Enhancer PlugIn.

 

L’applicazione AKVIS Enhancer dovrà essere trascinata nella cartella Applicazioni.

La cartella AKVIS Enhancer Plugin dovrà essere trascinata nella cartella Plug-Ins dell'editor di grafica:

Photoshop CC 2022, CC 2021, CC 2020, CC 2019, CC 2018, CC 2017, CC 2015.5: Library/Application
Support/Adobe/Plug-Ins/CC,

Photoshop CC 2015: Applications/Adobe Photoshop CC 2015/Plug-ins,

Photoshop CS6: Applications/Adobe Photoshop CS6/Plug-ins.

Per altri versioni dei programmi di grafica il metodo è analogo.
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Dopo l’installazione del plugin si possono vedere una nuova voce nel menu Filtri dell'editor: Fitro -> AKVIS –> Enhancer.

Eseguire il programma standalone facendo doppio clic sull'icona nel Finder.

Inoltre, è possibile eseguire il programma AKVIS dall'app Foto selezionando il comando Immagine -> Modifica con (in High
Sierra e versioni successive di macOS).
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REGISTRAZIONE DEI PROGRAMMI AKVIS

Attenzione! Durante il processo di attivazione il computer deve essere collegato a Internet.

Se ciò non fosse possibile offriamo un metodo alternativo (vedi sotto come registrare offline).

 

Scaricare ed installare AKVIS Enhancer. Leggi le istruzioni di installazione qui.

Quando si esegue la versione non registrata, viene visualizzata una finestra con le informazioni generali sulla versione del
software ed il numero di giorni rimanenti del periodo di prova.

Inoltre, è possibile aprire la finestra Informazione sul software premendo il pulsante  nel programma.

 

Cliccare sul pulsante PROVA per usufruire del periodo di prova. Si apre una nuova finestra con le varianti delle licenze per
testare il programma. Durante il periodo di valutazione di 10 giorni non è necessario registrare il software per provare
gratuitamente le funzionalità complete.

Durante il periodo di prova è possibile scegliere tra questi tipi di licenze: Home (Plugin oppure Standalone), Deluxe o
Business. La tua scelta definisce quali funzioni saranno disponibili nel programma. Questo ti aiuterà a decidere quale tipo di
licenza soddisfa di più le tue esigenze.  Consulta la pagina di confronto per ulteriori dettagli sulle licenze e versioni del
prodotto.

Se il periodo di prova è scaduto, il pulsante PROVA è disattivato.

 

Cliccare sul pulsante ACQUISTA per scegliere e ordinare la licenza del prodotto.

Una volta completata la transazione riceverai entro pochi minuti, al tuo indirizzo e-mail, il numero di serie per il programma.

 

Cliccare sul pulsante REGISTRA per avviare il processo di attivazione.
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Immettere il tuo nome (il programma sarà registrato a questo nome) e il numero di serie per il programma.

Scegliere il metodo di attivazione: connessione diretta o via e-mail.

Connessione diretta:

L’attivazione diretta è il metodo più semplice e immediato, richiede una connessione Internet attiva.

Premere REGISTRA.

La registrazione è completata!

Richiesta via e-mail:

Nel caso tu abbia scelto di attivare il prodotto via e-mail, viene creato un messaggio con tutte le informazioni
necessarie.

NOTA: Questo metodo può essere utilizzato anche per la Registrazione offline.

Se il computer non è collegato a Internet, trasferire il messaggio di attivazione a un altro computer con la connessione
Internet, usando una penna USB, e invialo a noi: activate@akvis.com.

Per favore non inviare la schermata! Basta copiare il testo e salvarlo.

Abbiamo bisogno di sapere il numero di serie del software, il tuo nome e il numero ID dell’Hardware (HWID) del tuo
computer.

Creeremo il file di licenza (Enhancer.lic) con queste informazioni e lo invieremo al tuo indirizzo e-mail.

Salvare il file .lic (non apprirlo!) nella cartella AKVIS che si trova in documenti condivisi (o pubblici):

Su Windows 7, Windows 8, Windows 10:

C:\Utenti\Pubblica\Documenti pubblici\AKVIS;

Su Mac:

Utenti/Condivisa/AKVIS.

La registrazione è completata!
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Quando il programma viene registrato, il pulsante ACQUISTA si trasforma in AGGIORNA, questo consente di migliorare la tua
licenza (ad esempio, cambiare la licenza Home in Home Deluxe o Business).
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AREA DI LAVORO

AKVIS Enhancer funziona come applicazione standalone (indipendente) e come plugin per i più diffusi programmi di grafica.

Standalone è un programma indipendente, è possibile aprirlo cliccando sull'icona del programma.

Per avviare la versione standalone eseguire direttamente il programma:

Su Windows selezionarlo dal menu Start o utilizzare la scorciatoia del programma.

Su Mac lanciare dalla cartella Applicazioni.

Plugin è un modulo aggiuntivo per un programma di grafica, ad esempio Photoshop.

Per lanciare il plugin selezionarlo dai filtri dell'editor grafico.

L'area di lavoro di AKVIS Enhancer appare così:

Area di lavoro di AKVIS Enhancer, scheda Dopo

La parte sinistra dell’area di lavoro di AKVIS Enhancer è occupata dalla Finestra immagine con due schede Prima e Dopo.
La scheda Prima visualizza l’immagine originale, la scheda Dopo mostra la foto elaborata. È possibile passare da una finestra
all’altra facendo clic sulla scheda con il tasto sinistro del mouse. Per confrontare l’immagine originale con quella creata, si può
anche cliccare sull'immagine premendo/rilasciando il tasto del mouse, il programma automaticamente passa da una scheda
all'altra.

È possibile definire l’aspetto della Finestra immagine e delle schede Prima/Dopo regolando la Modalità di visualizzazione
immagine nella parte inferiore della Barra degli strumenti.

 

Nella parte superiore della finestra c’è il Pannello di controllo con i seguenti comandi:

Il pulsante  apre la pagina Web del programma AKVIS Enhancer.

Il pulsante  permette l’apertura  dell'immagine per l’elaborazione (solo nella versione standalone). Tasti rapidi

Ctrl+O  su Windows, ⌘ +O  su Mac.

È possibile visualizzare l'elenco dei file recenti cliccando con il tasto destro del mouse su questo pulsante. Nelle
preferenze del programma si può impostare il numero di documenti recenti da visionare.

AKVIS Enhancer
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Il pulsante  permette di salvare l'immagine sul disco (solo nella versione standalone). Tasti rapidi Ctrl+S  s u

Windows, ⌘ +S  su Mac.

Il pulsante  apre la finestra di dialogo Stampa per stampare l'immagine (solo nella versione standalone). Tasti rapidi

Ctrl+P  su Windows, ⌘ +P  su Mac.

Il pulsante  consente di pubblicare le immagini dal programma sui social network.

Il pulsante  permette di importare un elenco di preset (file .enhancer).

Il pulsante  permette di esportare i preset (impostazioni salvate per un successivo utilizzo). E' possibile salvare un

numero illimitato di preset con estensione .enhancer.
Il pulsante  (solo nella versione standalone) apre la finestra di dialogo Elaborazione batch per elaborare

automaticamente un gruppo di foto.
Il pulsante  (solo nelle modalità  Prestampa e  Correzione toni) avvia il trattamento dell'immagine con le

impostazioni attuali dei parametri.
Il pulsante  (solo nella versione plugin) consente di chiudere la finestra del plugin ed applicare il risultato nell’editor

di foto.
Il pulsante  mostra le informazioni sul software, sulla licenza e sulla versione.

Il pulsante  apre i file d'Aiuto del programma. Tasto rapido F1 .

Il pulsante  apre la finestra di dialogo Preferenze che permette di modificare le impostazioni del programma.

Il pulsante  apre una finestra che mostra le ultime notizie su Enhancer.

La Barra degli strumenti si trova alla sinistra della finestra immagine:

Il pulsante  (solo nelle modalità Prestampa e Correzione toni) attiva/disattiva la finestra di anteprima.

Il pulsante  (solo nella versione standalone) attiva lo strumento Taglierina che consente di ritagliare aree

indesiderate dell'immagine.
Il pulsante  attiva lo strumento Mano che permette di scorrere l'immagine nella finestra qualora l'intera immagine

abbia una dimensione non adatta ad essa. Per spostare l'immagine selezionare lo strumento, posizionare il cursore
all’interno della foto, premere il tasto sinistro del mouse e, tenendolo premuto, spostare l'immagine nella finestra.

Facendo doppio clic sull'icona , sulla Barra degli strumenti, adatta l'immagine alla Finestra immagine.

Il pulsante  attiva lo strumento Zoom che permette di scalare l'immagine. Per aumentare la scala dell'immagine fare

clic con il tasto sinistro del mouse sull'immagine. Per ridurla usare il tasto sinistro del mouse + Alt . Premere Z  per

accedere rapidamente a questo strumento.

Facendo doppio clic sull'icona , sulla Barra degli strumenti, mostra l'immagine nelle dimensioni reali, impostando la

scala al 100%.

Nella parte inferiore del questo pannello ci sono tre pulsanti che servono a definire l’aspetto della Finestra immagine.

Navigare e scalare l'immagine usando la finestra Navigatore. La cornice mostra la parte dell’immagine visibile al momento nella
finestra principale; l’area esterna ad essa sarà ombreggiata. Trascinando la cornice si potranno vedere altre parti
dell’immagine, durante lo spostamento la cornice cambia colore diventando verde. Per spostarla portare il cursore al suo
interno, premere il tasto sx del mouse e, mantenendolo premuto, trascinare la cornice.

Per far scorrere l'immagine premere la barra spaziatrice sulla tastiera e trascinare l'immagine premendo il tasto sinistro di
mouse, il cursore si trasformerà in una mano. Oppure utilizzare la rotella del mouse per spostare l’immagine su/giù;
mantenendo il tasto Ctrl  premuto, utilizzare la rotella del mouse per spostare l’immagine a destra/sinistra; mentre per
ridurre/ingrandire l’immagine premete il tasto Alt  utilizzando sempre la rotella del mouse.

Per scalare l'immagine usare il cursore. Spostando il cursore verso destra, la scala dell'immagine aumenta. Spostando il cursore
verso sinistra, la scala dell'immagine si riduce.

È possibile cambiare la scala dell'immagine anche immettendo un nuovo coefficiente nel campo della scala.

Inoltre, sempre per modificare la scala dell'immagine, si possono usare i tasti rapidi: +  per aumentarla e -  per ridurla.
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Sotto il Navigatore c’è i l   Pannello impostazioni in cui è possibile selezionare una delle  Modalità e regolare le sue
impostazioni.

Nel campo Preset si possono salvare le impostazioni preferite come un preset (predefinito) per usarlo successivamente. Le
impostazioni possono essere salvate, modificate, cancellate. Quando si avvia il programma o il plugin vengono utilizzate le
impostazioni del preset usato per ultimo.

Sotto il Pannello impostazioni, per impostazione predefinita, è possibile vedere alcuni Suggerimenti: una breve descrizione
del parametro/pulsante quando il cursore passa sopra uno di essi. Cliccando su  (preferenze del programma) è possibile

modificare la posizione del campo Suggerimenti oppure nasconderlo.
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MODALITÀ DI VISUALIZZAZIONE IMMAGINE: PRIMA E DOPO

Nella parte inferiore della Barra degli strumenti di AKVIS Enhancer ci sono tre pulsanti che servono a definire l’aspetto della
Finestra immagine e organizzare le schede Prima e Dopo.

Cliccare sul primo pulsante per aprire un sottomenu che contiene diverse opzioni di visualizzazione delle immagini originali
ed elaborate:

- Il pulsante  appronta la modalità standard della finestra con le schede Prima e Dopo.

- I pulsanti  e   predispongono la finestra principale divisa in due parti, sia verticalmente che

orizzontalmente. L'immagine originale ed il risultato sono parzialmente visibili, infatti le schede vengono combinate,
formando l'intera immagine.

Con queste disposizioni è possibile trascinare il separatore cambiando le proporzioni delle parti Prima e Dopo.

- I pulsanti  e  dividono anch’essi la finestra a metà, verticalmente o orizzontalmente, tuttavia, a

differenza della precedente opzione, le finestre visualizzano lo stesso frammento dell'immagine prima e dopo
l'elaborazione.

Nota: Utilizzare le finestre affiancate è conveniente se si desidera confrontare il frammento dell’immagine originale con
quello elaborato in un unico schermo. Per visualizzare interamente l'immagine finale, selezionare la modalità standard.

Il pulsante  inverte la posizione delle immagini (originale ed elaborata) quando si usano le doppie finestre.
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Il terzo pulsante consente di selezionare il colore di sfondo della Finestra immagine. Premere su ,  o  per

impostare il colore di sfondo bianco, grigio o nero. Cliccando su  viene aperta la finestra di dialogo Seleziona colore

in cui è possibile fare la scelta preferita.
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COME USARE IL PROGRAMMA

AKVIS Enhancer permette il recupero e l'ottimizzazione dei dettagli sulle foto, consente di correggere le foto scure, regolare
la tonalità, il contrasto e la luminosità delle immagini. Il software funziona come applicazione standalone e come plugin per i
più diffusi programmi di grafica.

Seguire queste istruzioni:

Passaggio 1. Aprire un'immagine.

- Se si lavora con il programma standalone:

La finestra di dialogo Seleziona file per l’apertura si apre facendo doppio clic sull’area di lavoro vuota del
programma o cliccando sull’icona  . Tasti rapidi Ctrl+O  su Windows, ⌘ +O  su Mac. È possibile anche

trascinare l'immagine scelta direttamente nell’area di lavoro del software.
Il programma standalone supporta i file in formato JPEG, TIFF, BMP, PNG e RAW.

- Se si lavora con il plugin:

Aprire un’immagine nell'editor di grafica selezionando il comando File -> Apri.

Poi lanciare il plugin AKVIS Enhancer dal menu Filtri/Effetti dell'editor di foto:

in AliveColors: Effetti -> AKVIS -> Enhancer; 
in Adobe Photoshop: Filtro -> AKVIS -> Enhancer; 
in Corel Paint Shop Pro: Effetti -> Plugins -> AKVIS -> Enhancer; 
in Corel Photo-Paint: Effetti -> AKVIS -> Enhancer.

Immagine iniziale

Passaggio 2. Nel Pannello impostazioni selezionare dal menu a discesa una delle modalità di elaborazione.
Migliorare i dettagli. Questa modalità è utilissima su immagini piatte e carenti di dettagli. Ad esempio, una foto
scattata con uno sfondo sovraesposto e conseguentemente di difficile lettura, è il tipico problema che si presenta
quando si scatta un panorama od un ritratto su uno sfondo.
Prestampa. Questa modalità permette d'elaborare le foto prima della stampa. Il programma aumenta la nitidezza
dei bordi ed il contrasto dell'immagine.
Correzione toni. Questa modalità  è utilizzata per correggere i toni dell'immagine, vale a dire che è adatta alla
correzione della luminosità delle aree chiare e scure, di conseguenza l'impressione generale dell’immagine migliora
notevolmente. Le modifiche possono essere effettuate sull'intera immagine oppure solo ad una parte di essa, a
seconda dei colori scelti per la correzione.

Il confronto tra le modalità può essere trovato qui.

Passaggio 3. Regolare i valori dei parametri della modalità selezionata nel Pannello impostazioni.
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Passaggio 4. Se le nuove impostazioni sono interessanti e soddisfacenti si possono salvare come preset ed usarle in un
secondo tempo. Per farlo è sufficiente inserire un nome nel campo Preset e premere il pulsante Salva; al successivo
avvio del programma verranno utilizzate quest’ultime impostazioni.

Quando il cursore passa sopra uno dei preset, appare un rapido risultato nella finestra di Anteprima preset.

Per elaborare l'immagine con un certo preset basta selezionarlo dall’elenco, l'immagine verrà automaticamente
trasformata con le corrispondenti impostazioni.

Se si desidera ritornare alle impostazioni iniziali del programma cliccare su Ripristina.

Per eliminare un preset è necessario selezionarlo dalla lista e cliccare sul pulsante Elimina.

Passaggio 5. Se necessario, si possono fare altre correzioni usando la scheda Post-elaborazione (disponibile solo
nella versione standalone).
Passaggio 6. Condividere l'immagine cliccando su  che apre l'elenco dei social network da pubblicare l'immagine.

La versione standalone permette di stampare l'immagine con il pulsante .
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Passaggio 7. Salvare l'immagine elaborata.

- Se si lavora con il programma standalone:

Premere il pulsante , inserire un nome per il file in Salva con nome, scegliere il formato (JPEG, TIFF, BMP o

PNG) ed indicare la cartella di destinazione.

- Se si lavora con il plugin:

Premere il pulsante  per applicare il risultato e chiudere la finestra del plugin.

Nell'editor di grafica richiamare la finestra di dialogo Salva con nome usando il comando File -> Salva con
nome, inserire un nome per il file, scegliere il formato ed indicare la cartella di destinazione.
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Ombre = 50 Ombre = 400

MIGLIORARE I DETTAGLI

La modalità Migliorare i dettagli è utilissima su immagini piatte e carenti di particolari. Il programma mette in evidenza i
dettagli sia in ombra che in luce.

Migliorare i dettagli

 

Seguire le istruzioni sottostanti per elaborare l'immagine nella modalità Migliorare i dettagli:

Regolare il valore del parametro Anteprima.

Il parametro Anteprima è ausiliario e non influisce sulla dimensione reale dell’immagine. L'immagine originale e tutte le sue
caratteristiche rimangono immutate.

Quando l'opzione Alta qualità è selezionata i parametri di elaborazione vengono applicati all'immagine nella sua dimensione
reale. Il tempo di elaborazione aumenterà ma la qualità dell'anteprima sarà più alta possibile. Se si seleziona l'opzione Veloce,
la dimensione dell'anteprima è inferiore all'immagine originale di 8 volte. Il tempo di elaborazione diminuirà di conseguenza, ma il
risultato sarà approssimativo. Per i valori intermedi la dimensione dell'anteprima è 2 e 4 volte più piccola dell'immagine
originale.

Nota: Una volta regolati i parametri, si consiglia di provare l’elaborazione Alta qualità per accertarsi di aver scelto la
configurazione ottimale.

 

Regolare i parametri di correzione dell'immagine. Tutte le modifiche vengono applicate automaticamente.

Ombre (0-500). Il parametro rafforza le aree d'ombra nell'immagine. Aumentando il valore le aree scure diventano
ancora più scure.

Luci (0-500). Il parametro illumina l'immagine. Aumentando il valore, le aree luminose diventano ancora più chiare.
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Luci = 50 Luci = 400

 

Saturazione = -25

 

Saturazione = 25

 

Contrasto sfumatura = 10

 

Contrasto sfumatura = 50

 

Livello dei dettagli = 5

 

Livello dei dettagli = 45

Saturazione (-50..50). Il parametro cambia l'intensità dei colori dell'immagine.

Contrasto sfumatura (0-50). Il parametro amplifica delicatamente il contrasto nelle aree con luminosità sfumata,
rendendo l'immagine più intensa ed espressiva.

Livello dei dettagli (0-50). Il parametro definisce il livello dei dettagli. Maggiore è il valore, più nitidi sono i contorni e
notevoli i dettagli visibili.

Soglia (1-10). Il parametro definisce le aree che vengono intensificate quando si aumenta il livello dei dettagli. A valori
bassi il programma rivela tutti i dettagli dell'immagine, a valori alti i piccoli dettagli non cambiano.
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Soglia = 2

 

Soglia = 10

 

Illuminazione = 5

 

Illuminazione = 20

Illuminazione (0-20). Il parametro permette di rischiarare le zone scure. Quando si aumenta il valore, l'immagine
appare più luminosa.
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Immagine originale

 
Risultato

ELABORAZIONE PRESTAMPA

Quando si stampa una foto il risultato è diverso da ciò che si vede sullo schermo. I contorni degli oggetti possono apparire
perfetti sul monitor, ma sfocati sulla carta. Per evitare questo inconveniente elaborare l'immagine prima della stampa.

Usare la modalità Prestampa per aumentare la nitidezza dei bordi ed il contrasto dell'immagine.

Anche se non si ha intenzione di stampare le foto, è possibile utilizzare questa modalità per migliorare le immagini; per
esempio, prima di pubblicare l'album online.

Per elaborare l'immagine nella modalità Prestampa attenersi alla seguente procedura:

Passaggio 1. Quando questa modalità è selezionata l’immagine elaborata con le impostazioni correnti appare nella
finestra di Anteprima rapida.

La finestra di anteprima è un riquadro contornato da una linea tratteggiata ("formiche in marcia") che visualizza le
modifiche apportate. È possibile trascinare l'area di anteprima nella posizione desiderata con il tasto sinistro del mouse o
con il doppio clic. Ogni volta che viene spostata il programma elabora automaticamente l’interno della zona. Per
confrontare rapidamente l'immagine originale con il risultato dell’elaborazione è sufficiente cliccare su un punto qualsiasi
all’interno della finestra di anteprima.

La dimensione della finestra di anteprima viene regolata nelle preferenze del programma.

Passaggio 2. Regolare le impostazioni d'elaborazione dell'immagine.

I parametri del gruppo Nitidezza possono essere usati per conseguire un'immagine più nitida e dettagliata.
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Raggio. Questo parametro, che accetta valori tra 1 e 100, determina la larghezza della zona in cui i bordi degli
oggetti vengono migliorati. Attenzione: un aumento significativo può portare artefatti intorno all’area stabilita.

Forza. Questo parametro influenza il grado di miglioramento del contrasto lungo i bordi degli oggetti. Maggiore è il
valore più l'immagine diventa nitida. Esso dipende dall’impostazione del Raggio. La scala va da 0 a 100.

I parametri del gruppo Contrasto permettono migliorare il contrasto dell'immagine, correggendo separatamente le aree
chiare e le aree scure, rendendole più luminose o più buie.

Ombre. Questo parametro accetta valori tra -50 e 100. Esso mette in risalto le aree d'ombra, aumentando il
valore le aree diventano più scure, diminuendolo le rende più chiare.

Luci. Questo parametro accetta valori tra -50 e 100. Spostando il cursore a destra dello 0, le aree luminose
dell’immagine diventano ancora più chiare, spostandolo verso sinistra si aumenta il numero dei toni di grigio.

Passaggio 3. Per avviare l’elaborazione dell'intera immagine premere su  .
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CORREZIONE TONI

La modalità Correzione toni è utilizzata per perfezionare i toni dell'immagine, vale a dire che è adatta alla variazione della
luminosità delle aree chiare e scure, di conseguenza l'impressione generale dell’immagine migliora notevolmente. Le modifiche
possono essere effettuate sull'intera immagine oppure solo ad una parte di essa, a seconda dei colori selezionati per la
correzione.

Correzione toni

Per elaborare l'immagine nella modalità Correzione toni, attenersi alla seguente procedura:

Passaggio 1. Quando questa modalità è selezionata l’immagine elaborata con le impostazioni correnti appare nella
finestra di Anteprima rapida.

La finestra di anteprima è un riquadro contornato da una linea tratteggiata ("formiche in marcia") che visualizza le
modifiche apportate. È possibile trascinare l'area di anteprima nella posizione desiderata con il tasto sinistro del mouse o
con il doppio clic. Ogni volta che viene spostata il programma elabora automaticamente l’interno della zona. Per
confrontare rapidamente l'immagine originale con il risultato dell’elaborazione è sufficiente cliccare su un punto qualsiasi
all’interno della finestra di anteprima.

La dimensione della finestra di anteprima viene regolata nelle preferenze del programma.

Passaggio 2. Scegliere i colori da correggere utilizzando i Set di colori. La serie originale è composta da sette colori,
nella zona sottostante ci sono altri due Set di colori, ciascuno dei quali è composto da tre celle. È possibile spostare i
colori della serie superiore, trascinandoli nelle celle inferiori, ottenendo così tre set. Per passare da un set all’altro è
sufficiente cliccare su di esso con il tasto sinistro del mouse, quello selezionato viene evidenziato in bianco.
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L'Indicatore di colore rende più facile creare un set di colori.

Quando si sposta il cursore su un punto dell'immagine vengono automaticamente scelti da uno a tre componenti.
L’Indicatore di colore visualizza quelli del punto corrispondente, esso aiuta a selezionare con maggiore precisione i Set
di colori per la modifica di quell’area.

Passaggio 3. I parametri fissati per ciascun Set di colori vengono regolati separatamente. Il set scelto ha uno sfondo
bianco. Regolare le seguenti impostazioni:

Raggio (1-60). Questo parametro determina la dimensione dell'area da esaminare. Dopo l’analisi vengono
assegnati a questa zona nuove informazioni di colore e luminosità, esse vengono utilizzate per attribuire uno dei
set. L’area viene quindi ulteriormente elaborata.

Ombre (0-100). Il valore predefinito di questo parametro è 0 e le aree scure non sono corrette. Aumentando il
valore le aree scure si schiariscono ed i dettagli diventano distinguibili. Gli oggetti con sagome scure recuperano
visibilità, ritornando com’erano al momento dell’inquadratura.

Luci (0-100). Per impostazione predefinita il valore di questo parametro è 0 e le aree chiare non vengono
corrette. Aumentando il valore le aree chiare diventano più scure, il contrasto è incrementato, gli oggetti vengono
messi in risalto, l'immagine complessiva ha più volume e appare maggiormente dettagliata.

Nota: Se i componenti di colore non appartengono allo stesso gruppo, l'applicazione dei parametri è mista. Ad
esempio, se i colori rossi e gialli sono in differenti set, la correzione per il colore arancione rientrerà in entrambi i
set di colori.

Passaggio 4. Per avviare l’elaborazione dell'intera immagine premere su  .
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Prima di Post-elaborazione

 
Dopo Post-elaborazione

POST-ELABORAZIONE

Usare la scheda Post-elaborazione per apportare correzioni aggiuntive all'immagine. Essa è disponibile solo nella versione
standalone.

La scheda contiene un Istogramma e quattro parametri regolabili: Luminosità, Contrasto, Gamma e Saturazione.

L’istogramma è un grafico che mostra il range tonale dell’immagine. L’asse delle X (la linea orizzontale) rappresenta la
luminosità, dal colore più scuro a quello più chiaro. L’asse delle Y (la linea verticale) rappresenta il numero di pixel con una
certa luminosità.

I tre cursori sotto l'istogramma possono essere utilizzati per modificare il contrasto dell'immagine.

Il punto estremo a destra rappresenta i pixel che hanno luminosità massima (i punti bianchi). Se l’istogramma non mostra tali
pixel, vuol dire che l’immagine non ha punti bianchi. Spostando il cursore bianco verso sinistra, il punto dove esso si trova avrà
la massima luminosità (255) e tutti i pixel aventi questo valore diventeranno bianchi. La luminosità di tutti gli altri pixel verrà
ricalcolata. L’immagine diventerà più chiara.

Il punto estremo a sinistra rappresenta i pixel che hanno luminosità minima (i punti neri). Se l'inizio dell'istogramma non è sul
punto estremo sinistro, vuol dire che l’immagine non ha punti neri (luminosità = 0). Spostando il cursore nero verso destra, il
punto dove esso si trova avrà la minima luminosità. Come risultato, questi pixel diventeranno neri e verrà ricalcolata la
luminosità di tutti gli altri pixel. L’immagine diventerà più scura.

Il cursore centrale rappresenta i toni dell’immagine che hanno il valore di luminosità uguale a 128 (grigio medio). Spostandolo
verso sinistra, i toni di grigio medio diventano più chiari; spostandolo verso destra, i toni di grigio medio diventano più scuri.

Accanto all’istogramma si trova un elenco a discesa di tutti i canali dell’immagine (RGB, Rosso, Verde, Blu, Colori,
Luminosità). È possibile regolare ciascun canale separatamente oppure correggere un canale combinato.

 

Nella scheda Post-elaborazione sono presenti i parametri che permettono di correggere la luminosità ed il contrasto
dell'immagine, nonché la gamma e la saturazione.

Il parametro Luminosità è utilizzato per cambiare la luminosità dell'immagine. Il suo valore è compreso tra -100 e 100; il
valore predefinito è 0. Maggiore è il valore più chiari sono i pixel dell'immagine e viceversa.
Il parametro Contrasto permette di aumentare (se il valore è superiore a 0) o ridurre (se il valore è inferiore a 0) la
differenza tra le zone chiare e scure dell’immagine. Il suo valore è compreso tra -100 e 100; il valore predefinito è 0.
Il parametro Gamma consente di cambiare il contrasto generale dell’immagine agendo sui mezzitoni e sui livelli di grigio
medio. Il suo valore è compreso tra 50 e 250; il valore predefinito è 100.
Il parametro Saturazione permette di modificare l’intensità dei colori dell’immagine. Il suo valore è compreso tra -100
(colore grigio) e 100 (colori saturati). Il valore predefinito è 0.
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Una volta modificati i parametri presenti in questa scheda, il programma elabora l’immagine automaticamente. Il risultato si
visualizza nella scheda Dopo.
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ELABORAZIONE BATCH

AKVIS Enhancer offre l'Elaborazione batch, cioè la possibilità di elaborare automaticamente ed in modo simultaneo un
gruppo di foto.

L'Elaborazione batch è disponibile per tutte le modalità del programma. Questa funzione è molto utile quando si devono
correggere numerose foto scattate in identiche condizioni e con le stesse impostazioni della fotocamera; un grande risparmio
di tempo e fatica…cosa non da poco!

Se si utilizza AKVIS Enhancer come il programma standalone, seguire queste istruzioni.

Se si utilizza il plugin Enhancer in Photoshop, leggere il tutorial qui.
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PREFERENZE DEL PROGRAMMA

Il pulsante  apre la finestra di dialogo Preferenze del programma, essa appare come questa:

Linguaggio. Questa opzione consente di cambiare l'interfaccia del programma in un'altra lingua. Scegliere quella
desiderata dal menu a tendina.
Scala dell'interfaccia. Scegliere la dimensione degli elementi dell'interfaccia. Quando il valore è impostato su Auto,
l'area di lavoro del programma cambia automaticamente per adattarsi alla risoluzione dello schermo.
Tema dell'interfaccia: Selezionare lo stile preferito per l'interfaccia del programma: Chiaro o Scuro.
Scala iniziale. Il parametro definisce il modo in cui l’immagine, dopo l’apertura, viene adattata alla finestra principale:

- Adatta alla visualizzazione. Ridimensionamento dell’immagine. La scala viene modificata affinchè l’immagine sia
completamente visibile.
- 100%. È utilizzata la dimensione reale, l’immagine non viene scalata.

Dimensione della finestra di anteprima. Scegliere la dimensione dell'area di Anteprima rapida per le modalità
Prestampa e Correzione toni: da 300х300 a 1000х1000 pixel.
File recenti (solo nella versione standalone). Questa opzione consente di stabilire il numero di documenti recenti, in
ordine di tempo, visualizzati nell’elenco e consultabili cliccando con il tasto destro del mouse su  , per un max di 30

file.
Suggerimenti. Selezionare come mostrare il campo dei suggerimenti:

- Sotto la Finestra immagine.
-  Sotto il Pannello impostazioni.
-  Nascondi.

Blocca il Pannello di controllo. Questa opzione disabilita la possibilità di nascondere/mostrare il pannello superiore. Se
la casella è selezionata il pannello è sempre visibile.
Usa GPU. Questa opzione permette di attivare l'accelerazione GPU. Se la scheda grafica sul computer non supporta
l'accelerazione GPU la casella sarà disabilitata.

Per applicare i cambiamenti premere OK.

Per ripristinare le impostazioni predefinite premere Predefinito.
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STAMPARE L'IMMAGINE IN ENHANCER

Nella versione standalone di AKVIS Enhancer è possibile stampare l'immagine. Premere il pulsante  per aprire le opzioni di

Stampa.

Opzioni di stampa in AKVIS Enhancer

Regolare i parametri che appaiono nel Pannello impostazioni:

Scegliere una stampante dalla lista dei dispositivi disponibili, impostare la risoluzione desiderata, così come il numero di
copie da stampare.

Nel gruppo Orientamento impostare la posizione della carta: Ritratto (verticale) o Paesaggio (orizzontale).

Fare clic sul pulsante Imposta pagina per aprire la finestra di dialogo in cui è possibile scegliere il formato della carta e
il suo orientamento, così come i margini di stampa.

Premere il pulsante Ripristina margini per ristabilire i margini della pagina alle dimensioni predefinite.

Modificare le dimensioni dell'immagine stampata regolando i parametri Scala, Larghezza, Altezza e l'opzione Adatta
alla pagina. Essi non influiscono sull'immagine ma solo sulla copia stampata. È possibile modificare le dimensioni
dell'immagine stampata specificando la scala in percentuale o inserendo nuovi valori di Larghezza e Altezza nei campi
corrispondenti.

Per regolare la dimensione dell'immagine al formato della carta attivare la casella Adatta alla pagina.

Spostare l'immagine sulla pagina con il mouse o allinearla con i pulsanti frecce.

È possibile attivare la Cornice per l'immagine, regolare la sua larghezza ed il colore.

Scegliere il Colore di sfondo cliccando sul rettangolo di colore.

Nella scheda Pagina è possibile regolare la stampa delle copie dell'immagine su un singolo foglio.
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Stampa pagina

Copie per pagina. Il parametro consente di specificare il numero di copie dell'immagine su una singola pagina.
Orizzontalmente e  Verticalmente. Questi parametri indicano il numero di righe e colonne per le copie
dell'immagine sulla singola pagina.
Spaziatura. Questo parametro imposta i margini tra le copie dell'immagine.

Nella scheda Poster è possibile personalizzare le opzioni di stampa dell'immagine su più pagine per la successiva
giunzione e realizzazione di una grande immagine.

Pagine. Se la casella è selezionata è possibile specificare il numero massimo delle pagine in cui si desidera
suddividere l'immagine. La scala dell'immagine viene modificata in base al numero dei fogli. Se la casella è
disabilitata il programma seleziona automaticamente il numero ottimale delle pagine secondo le dimensioni effettive
dell'immagine (scala = 100%).
Margini per adesivo. Se la casella è selezionata è possibile regolare la larghezza dello spazio per la giuntura dei
fogli. I margini vengono inseriti sul lato destro e inferiore di ogni sezione.
Mostra numeri. Se la casella è selezionata, ai margini viene stampato il numero d'ordine di ogni sezione, per
colonna e riga.
Linee di taglio. Attivare la casella per visualizzare ai margini i segni di taglio.

Premere il pulsante Stampa per stampare l'immagine con le impostazioni selezionate. 
Per annullare e chiudere le opzioni di stampa premere su Annulla.

Fare clic sul pulsante Proprietà… per aprire la finestra di dialogo di sistema che consente di accedere alle impostazioni
avanzate ed inviare il documento da stampare.
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GUSTOSE FRAGOLE

La modalità  Correzione toni in AKVIS Enhancer è utile quando si desidera aumentare o diminuire la luminosità di uno
specifico colore in un'immagine.

Questa foto di succose fragole è una dimostrazione perfetta.

 

Aprire l’immagine.

Come si può osservare, è basilare migliorare il colore dei frutti, perciò trascinare il colore rosso dall’insieme dei colori iniziali in
uno dei set vuoti.

Il set di colori selezionato viene evidenziato in bianco.

Regolare le impostazioni per questo set portando Luci a 70 e Raggio a 45, ciò si traduce in un corposo colore dei frutti,
decisamente più scuri, lasciando inalterato quello delle foglie.

Ora è necessario scurire il colore delle foglie trascinando il verde nell’altro set libero.
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Aumentare il parametro Luci a 90.

Premete su  per applicare le modifiche all'intera immagine.

Risultato perfetto! Le foglie sono più scure, i frutti corposi, i fiori intatti, e complessivamente l’immagine si presenta più
naturale.

In questo modo, il rafforzamento o l'indebolimento di specifici colori in un'immagine, può portare a risultati diversi, abbastanza
piacevoli, spesso fondamentali e decisivi per valorizzare una fotografia.

 

TRASPARENTE COME CRISTALLO
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Immagine originale

 

Risultato finale

TRASPARENTE COME CRISTALLO

Guardando questa foto si pensa subito che tutto è molto limpido, ma se la si elabora con AKVIS Enhancer in modalità
Prestampa si potrà notare un cospicuo aumento delle definizioni, solo allora si potrà veramente comprendere la definizione
"limpidezza"!

In questo tutorial verrà elaborata una foto con cubetti di ghiaccio. Sembra già buona, ma non evoca la sensazione di
trasparenza, vedere attraverso i cubetti di ghiaccio come se fossero vetro ghiacciato è un’altra cosa.

Cliccare sull'immagine per vederla nelle dimensioni reali

Passaggio 1. Aprire l'immagine in AKVIS Enhancer e scegliere la modalità Prestampa.

Passaggio 2. La Finestra di anteprima mostra il risultato dell’immagine elaborata con le impostazioni predefinite.
L'immagine appare più nitida, ma per ottenere un risultato migliore dovrebbero essere ulteriormente regolati i parametri:

Raggio = 20     Forza = 75     Ombre = 70     Luci = 45.

Passaggio 3. Tutto quello che resta da fare è cliccare su   per applicare le modifiche.

I dettagli nell’immagine risultante sono chiari, come si può notare dalle piccole gocce d'acqua, i cubetti di ghiaccio
hanno un aspetto così naturale che viene quasi voglia di toccarli!
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Risultato finale
Cliccare sull'immagine per vederla nelle dimensioni reali
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Prima

 
Dopo

SCHIARIRE UNA FOTO SCURA DELLA STRADA

Scattando fotografie per strada, o in caratteristici vicoletti, può capitare che il soggetto principale della foto venga a trovarsi
in zone scarsamente illuminate e poco visibili. Con la modalità Migliorare i dettagli in AKVIS Enhancer è possibile enfatizzare
i dettagli nelle zone d'ombra.

AKVIS Enhancer funziona come applicazione autonoma (standalone) e come plugin per i più diffusi programmi di grafica.
Seguire questi passaggi per migliorare una foto con il plugin Enhancer (il metodo di lavoro nel programma standalone è
analogo):

Passaggio 1. Aprire la fotografia nel programma di editor grafico.

Passaggio 2. Lanciare AKVIS Enhancer selezionandolo dal menu Effetti -> AKVIS -> Enhancer in AliveColors; in
Adobe Photoshop Filtri -> AKVIS -> Enhancer; in Paint Shop Pro Effetti -> Plugins -> AKVIS -> Enhancer.

Selezionare la modalità Migliorare i dettagli. L'immagine verrà elaborata con le impostazioni predefinite.
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Passaggio 3. Poichè l'area da trattare si trova nella zona d'ombra incrementare il parametro Illuminazione e regolare
altre impostazioni per ottenere l'aspetto desiderato.

Passaggio 4. Una volta raggiunto l'effetto desiderato premere il pulsante  per applicarlo e chiudere il plugin.
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PROGRAMMI DI AKVIS

 

AKVIS AirBrush — Aerografia: Moderna tecnica di pittura

AKVIS AirBrush permette d'imitare la tecnica artistica dell’aerografia.  Il software trasforma automaticamente qualsiasi
immagine in un capolavoro raffinato di impagabile attrattiva, il quale sembra realmente compiuto dalle mani di un esperto
aerografista. Il programma agisce come filtro artistico creando eleganti disegni aerografati, convertendo le immagini in base
alle impostazioni selezionate. Maggiori informazioni…

 

AKVIS Artifact Remover AI — Ottimizzazione delle immagini compresse JPEG

AKVIS Artifact Remover AI utilizza algoritmi di intelligenza artificiale per rimuovere gli artefatti di compressione JPEG e
ripristinare la qualità originale delle immagini compresse. Il software è disponibile gratuitamente. È uno strumento
indispensabile sia per gli utenti inesperti che per i professionisti. Maggiori informazioni…

 

AKVIS ArtSuite — Effetti artistici e cornici per foto

AKVIS ArtSuite è una fantastica collezione di cornici ed effetti molto versatili per foto. Il software rende facile aggiungere
eleganza e stile ad un ritratto o ad un paesaggio.

Il programma contiene numerosi modelli dipinti a mano e campioni di vari materiali che possono essere utilizzati per creare una
varietà pressoché illimitata di cornici, oltre a molteplici e particolari effetti. Maggiori informazioni…
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AKVIS ArtWork — Collezione versatile di tecniche pittoriche

AKVIS ArtWork applica diverse tecniche di pittura e disegno alle immagini digitali creando opere d'arte dalle foto. Il
programma offre questi effetti: Olio, Acquerello, Guazzo, Fumetti, Penna e inchiostro, Linoleografia, Pastello e  Puntinismo.
Maggiori informazioni…

 

AKVIS Chameleon — Fusione fotografica: composizioni e collage

AKVIS Chameleon è un programma per la fusione di immagini. Il software è facile e divertente da usare e non richiede la
selezione precisa degli oggetti. Chameleon adatta automaticamente gli oggetti inseriti alla gamma cromatica della foto (proprio
come fa un camaleonte) fondendoli in maniera armonica. Maggiori informazioni…
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AKVIS Charcoal — Disegni a carboncino e gessetto

AKVIS Charcoal è uno strumento artistico per la conversione delle fotografie in disegni a carboncino e gessetto. Con il
programma è possibile creare immagini espressive in bianco e nero dall'aspetto professionale. Giocando con i colori, si possono
ottenere eccezionali effetti artistici come simulare un disegno sanguigno o altro. Maggiori informazioni…

 

AKVIS Coloriage — Aggiungere colore a foto in bianco e nero

AKVIS Coloriage permette di manipolare i colori di una fotografia: aggiungere colore a fotografie in B&N, modificare le tinte di
una foto a colori, effettuare la desaturazione e colorazione selettiva di alcune aree, ecc. Il software aiuta a dare nuova vita
alle tue fotografie in bianco e nero, portare un aspetto vintage o artistico alle immagini digitali. Maggiori informazioni…

 

AKVIS Decorator — Applicare nuove texture e ricolorare

AKVIS Decorator permette di applicare nuove texture e nuovi materiali alle fotografie, o a parte di esse, senza alterare la
profondità delle immagini e in modo molto realistico. È possibile cambiare il look dei tuoi amici dando loro dei capelli
appariscenti o metallici, trasformare un uomo in extra-terrestre, applicare una pelle d’animale alla tua auto, convertire un vaso
di vetro in un vaso d'oro e molto, molto altro ancora! Maggiori informazioni…
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AKVIS Draw — Effetto disegno a matita fatto a mano

AKVIS Draw trasforma la tua foto in un disegno a matita che sembra fatto a mano. Il software crea realistiche illustrazioni
line art, produce disegni sia in bianco e nero che a colori. Conferisci alle tue foto un aspetto artistico con il programma Draw!
Maggiori informazioni…

 

AKVIS Enhancer — Recupero dei dettagli di una foto

AKVIS Enhancer migliora ogni parte dell'immagine, permettendo il recupero e l'ottimizzazione dei dettagli anche in foto
sottoesposte, sovraesposte e in aree dai mezzi toni, senza però modificarne l'esposizione. Il software porta alla luce i dettagli
intensificando la transizione di colore. Il programma funziona in tre modalità: Migliorare i dettagli, Prestampa e  Correzione
toni. Maggiori informazioni…

 

AKVIS Explosion — Favolosi effetti di esplosione e disgregazione

AKVIS Explosion offre effetti creativi di disgregazione ed esplosione per le foto. Il software consente di far esplodere un
oggetto sull'immagine ed applicare polvere e particelle di sabbia. Crea grafiche strepitose in pochi minuti! Maggiori
informazioni…
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AKVIS Frames — Decora le tue foto con piacevoli cornici

AKVIS Frames è un software gratuito progettato per utilizzare i pacchetti di cornici AKVIS

 

AKVIS HDRFactory — Immagini HDR: Più luminoso della realtà!

AKVIS HDRFactory permette di creare un'immagine HDR da una serie di scatti con diversa esposizione o da una fotografia. Il
software può essere utilizzato anche per la correzione di fotografie.

Il programma riempie le tue foto di vita e colore! Maggiori informazioni…

 

AKVIS LightShop — Effetti di luci e stelle

AKVIS LightShop aiuta a generare stupefacenti effetti di luci: un lampo in un cielo tempestoso, un arcobaleno variopinto
sopra una città, un riflesso su una goccia di pioggia, l'incandescenza della brace in un camino, insoliti segni luminosi nel cielo
notturno, raggi infiammati sul sole, luci di lontani pianeti, fuochi d'artificio - dovunque la tua immaginazione possa portarti!
Maggiori informazioni…
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AKVIS Magnifier AI — Ingrandimento e riduzione di immagini

AKVIS Magnifier consente di ridefinire le immagini senza perdita di qualità. Il programma implementa avanzati algoritmi basati
su reti neurali che consentono di ingrandire immagini arrivando a risoluzioni altissime. Maggiori informazioni…

 

AKVIS MakeUp — Migliorare e ritoccare ritratti

AKVIS MakeUp migliora i ritratti e aggiunge fascino alle foto, conferendo loro un aspetto professionale. Il software ritocca i
piccoli difetti sulla pelle, rendendola luminosa, bella, pulita e liscia, come si può vedere nelle immagini di grande valore
artistico. È incredibile quanto un bel colorito possa rigenerare e rinfrescare un look! Maggiori informazioni…

 

AKVIS NatureArt — Fenomeni della natura per foto digitali

AKVIS NatureArt è un ottimo strumento per imitare l’immensa bellezza dei fenomeni della natura sulle foto digitali. Il software
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offre questi effetti della natura: Pioggia

 

AKVIS Neon — Dipinti luminescenti dalle foto

AKVIS Neon consente di creare incredibili effetti con tratti luminosi. Il software trasforma una foto in un disegno al neon che
sembra realizzato con inchiostri luminescenti. Maggiori informazioni…

 

AKVIS Noise Buster AI — Riduzione rumore digitale

AKVIS Noise Buster AI è un software per la riduzione del rumore fotografico su immagini digitali e scansionate. Il programma
è efficiente per rimuovere qualsiasi tipo di rumore. Riduce il rumore di luminanza e cromatico su immagini digitali senza rovinare
gli altri aspetti della foto. Il software include tecnologie AI e regolazioni per la raffinazione manuale. Maggiori informazioni…
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AKVIS OilPaint — Effetto pittura ad olio

AKVIS OilPaint trasforma le fotografie in dipinti ad olio. La misteriosa trasformazione accade davanti ai tuoi occhi. L'esclusivo
algoritmo riproduce fedelmente la reale tecnica del pennello. Con questo software all'avanguardia puoi diventare anche tu un
pittore! Maggiori informazioni…

 

AKVIS Pastel — Pittura a pastello da una foto

AKVIS Pastel trasforma le tue foto in dipinti a pastello. Il programma converte un'immagine in arte digitale imitando una delle
più famose tecniche pittoriche - l'arte del pastello. Il software è un potente strumento per liberare la tua creatività! Maggiori
informazioni…

 

AKVIS Points — Applicare alle foto l'effetto puntinismo

AKVIS Points consente di trasformare le foto in dipinti con una delle tecniche più interessante e affascinante del mondo
artistico: il puntinismo. Con questo software è possibile realizzare facilmente delle stupende opere d'arte come un vero pittore
puntinista. Scopri il mondo dei colori brillanti! Maggiori informazioni…
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AKVIS Refocus AI — Effetti di nitidezza e sfocatura

AKVIS Refocus AI ristabilisce la nitidezza delle fotografie sfocate, migliora l'intera immagine o parzialmente, creando la messa
a fuoco selettiva. Inoltre, è possibile aggiungere effetti di sfocatura e bokeh alle foto. Il programma funziona in cinque
modalità:  Messa a fuoco AI, Miniatura (Tilt-Shift), Sfocatura iride, Sfocatura movimento e  Sfocatura radiale. Maggiori
informazioni…

 

AKVIS Retoucher — Restauro fotografico

AKVIS Retoucher è un programma per la rimozione di polvere, graffi e macchie.

Grazie a particolari algoritmi il programma è in grado di rimuovere digitalmente tutti i problemi e le imperfezioni delle vecchie
fotografie come polvere, graffi, oggetti non desiderati. Maggiori informazioni…
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AKVIS Sketch — Trasforma foto in disegni a matita

AKVIS Sketch è un programma per convertire foto in disegni a matita. Il software crea realistici disegni a colori e schizzi in
bianco e nero imitando la tecnica della grafite e dei pastelli colorati. Il programma offre questi stili: Classico, Artistico e
Maestro, ognuno con numerosi preset pronti all'uso. AKVIS Sketch consente di sentirti un vero artista! Maggiori informazioni…

 

AKVIS SmartMask — Strumento efficace di selezione

AKVIS SmartMask permette di selezionare gli oggetti e rimuovere gli sfondi. Mai prima d'ora realizzare una selezione è stato
così semplice ed efficace! SmartMask rende talmente semplice anche una selezione complicata da richiedere molto meno
tempo, consentendoti così di dedicarti alla tua creatività. Maggiori informazioni…

 

AKVIS Watercolor — Dipinti ad acquerello dalle foto

AKVIS Watercolor crea in modo facile ed efficace meravigliosi dipinti ad acquerello dalle foto. Il software trasforma immagini
ordinarie in incredibilmente realistici opere d'arte con la tecnica acquerello. Maggiori informazioni…
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